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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2003 - 2006 Hewlett-Packard Development Company, L.P.

Trademark Notices

Windows® and MS Windows® are US registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

OpenView is a U.S. registered trademark of Hewlett-Packard Development Company, L.P. 

Java™ is a U.S. trademark of Sun Microsystems, Inc.

All other product names are the property of their respective trademark or service mark holders and are 
hereby acknowledged.
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Documentation Updates

To verify that the manual you are using is in fact the most recent edition, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

Locate the product, then look to see if a more recent edition of this document is available for downloading. If 
you subscribe to the appropriate product support service, you can arrange to have document updates sent to 
you. Contact your HP sales representative for details.

The following table provides a list of changes made to this document since the last update in December 2005.

Chapter Changes

Chapter 1 Minor editorial enhancements.

Chapter 2 Minor editorial enhancements.

Chapter 3 Minor editorial enhancements.
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Support

Please visit the HP OpenView web site at:

http://www.managementsoftware.hp.com/ 

This site provides contact information and details about the products, services, and support that HP 
OpenView offers.

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a valuable 
support customer, you can use the support site to:

• Search for knowledge documents of interest

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Enter discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and log in. Many areas also 
require a support contract. 

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to:

http://managementsoftware.hp.com/passport-registration.htm
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1 Overview
This chapter covers the following topics:

• OVPI and device resources

• New features in version 3.1

• Reports and datapipes

• Integration with Network Node Manager (NNM)

• Ways to customize reports

• Sources for additional information

OVPI and Device Resources

HP OpenView Performance Insight (OVPI) is a performance management and reporting 
application. Long-term data collection, in-depth analysis, and automated web-based reporting 
are this application’s primary strengths. If desired, OVPI can be integrated with network 
management and system management applications, including NNM and OVO. Integration 
enhances fault isolation, problem diagnosis, and capacity planning.

The Device Resource Report Pack installs on OVPI. The reports in this package monitor CPU, 
memory, and buffer resources in switches, routers, the switch backplane, and cards installed 
on devices. Resources function independently. If a buffer is overutilized, the CPU that moves 
data in and out of the buffer could be underutilized; if the CPU is overutilized, buffer and 
memory could be underutilized. The Device Resource Report Pack does not monitor server 
resources. Use the System Resource Report Pack to monitor server resources.

You have synergies to exploit by running Device Resource with the Interface Reporting Report 
Pack. If Interface Reporting is showing high discards or high errors, Device Resource will tell 
you whether or not overutilization of a resource could be contributing to the problem. You can 
also move in the reverse direction. If Device Resource indicates that network response time is 
spiking, Interface Reporting will tell you whether interface utilization levels are contributing 
to the problem.

New Features in Version 3.1

Device Resource 3.1 is one of three enhanced report packs. The other two are Interface 
Reporting 5.1 and System Resource 4.2. The enhanced report packs offer the following 
improvements:

• Report linking

• Launch Point 
7



• Ad hoc selector reports

• Color-coded graphics in selection tables

• One-step upgrade packages

The links in reports allow you to move quickly from one report to another without having to 
close the report you are viewing, return to a directory, and then select another report. 
Navigating reports is now more like navigating a website—you have numerous links to work 
with and investigating a specific area of interest is easier and more efficient. In addition to 
moving from one report to another report within the same report pack, you can also link to 
reports in a different report pack. For example, from a report in Device Resource you can link 
to a report in the Interface Reporting Report Pack.

The Launch Point page provides an overview of package contents by grouping reports into 
logical categories, for example, Near Real Time reports, forecasting reports, and ad hoc 
selector reports. The ad hoc selector option opens an abbreviated report that lets you select 
specific elements from a set of drop-down menus. The drop-down menus make it easy to 
pin-point an item of interest. In addition, response time is especially good. Since this report 
launches just a few queries against the database, you won’t wait long for data to appear.

Device Resource 3.1 has upgrade packages that eliminate the need for a version-by-version 
upgrade. Starting and stopping Package Manager multiple times is no longer necessary. 
Instead, you can now upgrade an existing package to the latest version by installing a single 
upgrade package. Note also that the main package and the backplane sub-package have 
matching version numbers. The main package is 3.1 and the backplane sub-package is 3.1.

The following table provides details about recent enhancements to Device Resource.

Version Release Date Features/Enhancements

1.0 January 2003 15 reports; Sybase support

1.0 May 2003 No changes

2.0 October 2003 OVPI Object Manager support
change form:
• Update Thresholds
backplane utilization reports:
• Historical Summary
• QuickView
• Snapshot
• Near Real Time QuickView
• Near Real Time Snapshot

3.0 April 2004 Oracle support
new datapipe:
• Dev Res Cabletron Datapipe
upgrade packages:
UPGRADE_DeviceResource_to_3
UPGRADE_DeviceResourceBackplane_to_3

3.0 August 2004 No changes

3.0 November 2004 new datapipe:
• Dev Res Juniper Router Datapipe 1.0
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Reports and Datapipes

Device Resource contains 20 reports. The report folders are:

• Customer (3 reports)

• Device (9 reports)

• Location (3 reports)

• Backplane (5 reports)

The following table indicates the contents of each folder. 

3.1 June 2005 Report linking
Launch Point page
Ad hoc selector reports
Color-coded graphics in selection tables
upgrade packages:
UPGRADE_DeviceResource_to_31
UPGRADE_DeviceResourceBackplane_to_31

3.1 March 2006 No changes

3.1 May 2006 No changes

Version Release Date Features/Enhancements

Report Type Customer Device Location Backplane

Exceptions Summary X

Card Historical Summary X

Historical Summary X X

Historical Summary Snapshot X

QuickView X

Snapshot X

NRT QuickView X X

NRT Snapshot X X

Forecast X X X

Service Level Management X

Summary X X

Top Ten X X X
Overview 9



The following vendor-specific datapipes collect data for Device Resource:

1 Dev Res 3COM Router Datapipe

2 Dev Res Alcatel Xylan Switch Datapipe

3 Dev Res Cabletron Datapipe

4 Dev Res Cisco Switch Datapipe

5 Dev Res Cisco Router Datapipe

6 Dev Res Enterasys Router Datapipe

7 Dev Res Enterasys Switch Datapipe

8 Dev Res Extreme Devices Datapipe

9 Dev Res Foundry Datapipe

10 Dev Res HP ProCurve Datapipe

11 Dev Res Juniper Router Datapipe

12 Dev Res Nortel Bay Datapipe

In addition to performance data, reports contain the following kinds of property information:

• IP addresses

• Host names

• Customers

• Locations

Property information is stored in tables maintained by Common Property Tables. If you are 
about to install Common Property Tables for the first time, you will not see customers or 
locations in reports until you import this information. You can import customers and locations 
in batch mode by creating a file and importing the contents, or you can import customers and 
locations using the “create new” forms bundled with Common Property Tables. For details 
about importing properties, refer to the Common Property Tables 3.5 User Guide. 

Integration with Network Node Manager (NNM)

If you use NNM as well as OVPI, you have the option of improving your ability to isolate 
faults and diagnose problems by integrating OVPI with NNM. To integrate OVPI and NNM, 
install the Integration Module. The Integration Module contains a set of packages for NNM 
and a set of packages for OVPI.

If NNM and OVPI are integrated, you should install the optional thresholds sub-package that 
comes with Device Resource. Installing the optional thresholds sub-package configures the 
Thresholds Module to detect threshold conditions related to CPU, buffer, and memory 
utilization. The Thresholds Module responds to a threshold condition by taking an action, and 
the default action is to send a breach trap to NNM. The breach trap received by NNM becomes 
an alarm in the NNM alarm browser, which the NNM operator can respond to by launching a 
Near Real Time report.

Configuring the Thresholds Module is not necessary. You do not need to define an action or 
specify a destination for breach traps. However, you are free to modify category, severity, and 
destination parameters. For details about these options, see the Thresholds Module 5.0 User 
Guide.
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Ways to Customize Reports 

You can customize reports by applying group filters, by applying constraints, by editing tables 
and graphs, and by importing property information (node names, host names, customers, and 
locations). Service providers, or any organization that wants to share reports with customers, 
will need group filters to create customer-specific reports. However, any user viewing a report 
can apply a constraint, edit tables, and edit graphs. 

Group Filters

If you want to share reports with your customers, you must configure OVPI to produce 
customer-specific reports. Here is an overview of the steps involved:

• Use Common Property Tables to import customer names and device locations

• Create a group account for all the users affiliated with each customer

• Create a group filter for each group account

For more information about creating filters, refer to the OVPI 5.1 Administration Guide. 

Applying Constraints

Editing a parameter applies a constraint to the report. The constraint eliminates the data you 
are not interested in. For example, if you edit the Customer Name parameter, data for every 
customer except the customer you typed in the Customer Name field drops from the report. 
Device Resource supports the following parameters: 

• Customer Name

• Customer ID

• Location Name

• Location ID

• Device Name

• Make

• Model

If you are using a web browser to view reports, edit parameters by clicking the Edit 
Parameters icon at the bottom right-hand corner of the report. When the Edit Parameters 
window opens, enter the constraint in the field and click Submit. If you are using Report 
Viewer, select Edit > Parameter Values from the menu bar. When the Modify Parameter Values 
window opens, click the Current Value field. Type a new value and click OK.

Sources for Additional Information

This user guide provides samples of some of the reports in Device Resource. The demo 
package that comes with Device Resource is complete, containing a sample of every report in 
the package. If you have access to the demo package and you want to know what 
fully-populated reports look like, install the demo package. Demo reports are interactive, but 
unlike real reports the data in a demo report is static.
Overview 11



The following documents are related to this manual: 

• Executive Summaries Report Pack 1.0 User Guide

• Common Property Tables 3.5 User Guide

• NNM/OVPI Integration Module 2.0 User Guide

• Thresholds Module 5.0 User Guide 

• OVPI Report Packs, CD-ROM Release Notes, May 2006

Information about bug fixes and recent changes to datapipes can be found in the following 
release statements:

• Device Resource Report Pack 3.1 Release Statement

• Dev Res 3COM Router Datapipe Release Statement

• Dev Res Alcatel Xylan Switch Datapipe Release Statement

• Dev Res Cabletron Datapipe Release Statement

• Dev Res Cisco Switch Datapipe Release Statement 

• Dev Res Cisco Router Datapipe Release Statement 

• Dev Res Extreme Devices Datapipe Release Statement

• Dev Res Foundry Datapipe Release Statement

• Dev Res HP ProCurve Datapipe Release Statement 

• Dev Res Juniper Datapipe Router Release Statement

• Dev Res Nortel Bay Datapipe Release Statement 

Manuals for OVPI, and manuals for the reporting solutions and shared packages that run 
on OVPI, can be downloaded from this site:

http://www.managementsoftware.hp.com

Select Support > Product Manuals to reach the Product Manuals Search page. The user guides for 
OVPI are listed under Performance Insight. The user guides for report packs and datapipes are 
listed under Performance Insight Reporting Solutions. Every document listed indicates the date. 
If a document is revised and reposted, the date will change. Since we post revised manuals on 
a regular basis, you should check this site for updates before using any PDF that was pulled 
from the Docs directory on the report pack CD-ROM.
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2 The Upgrade Install
This chapter covers the following topics:

• Guidelines for a smooth upgrade

• Upgrading from version 2.0 to version 3.1

• Post-Installation steps

• Removing Device Resource 3.1

Guidelines for a Smooth Upgrade

If you ran the package extraction program, the upgrade packages for Device Resource, as well 
as the latest version of the datapipes used by Device Resource, are already in the Packages 
direction on your system awaiting installation. Start Package Manager and follow the 
familiar on-screen instructions for upgrading a report pack.

If the extraction step has not taken place yet, insert the report pack CD in the CD-ROM drive 
and use the package extraction program to copy packages from the CD to the Packages 
directory on your system. After the extract finishes, the install script prompts you to start 
Package Manager. Before using Package Manager, review the following guidelines:

• Software prerequisites for Device Resource

• Datapipes and remote pollers

• Custom table views

• Upgrading Device Resource in a distributed environment

Software Prerequisites for Device Resource

Version 3.1 of Device Resource has the following prerequisites:

• OVPI 5.1

• All service packs available for OVPI 5.1

• Common Property Tables 3.5

Upgrading in a Distributed Environment

If you installed Device Resource 2.0 on multiple servers running OVPI 4.6, you created a 
distributed environment by using DS EDIT to set up connections with satellite server 
databases. You also configured trendcopy pull commands from the central server and switched 
off hourly aggregations at each satellite server. If you recently upgraded to OVPI 5.0 or OVPI 
5.1, the following changes must be repeated once the report pack is upgraded:
  13



• Setting up connections with satellite databases (using the Add Database Wizard)

• Configuring trendcopy pull commands

For details, see Chapter 4, Distributed Systems.

Datapipes and Remote Pollers

If you uninstall an existing datapipe, you will lose the following information:

• Single polling policy for a remote poller

• Cloned polling policies for multiple remote pollers

• Customized polling groups 

To prevent this information from being lost, you can export existing polling policy 
configurations and customized polling groups by using the following commands:

• collection_manager

• group_manager 

Exporting Polling Policy Configurations

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export existing policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst

Windows: As Administrator, launch a command window. Navigate to the OVPI install 
directory and execute the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, execute the following command: 

cd $DPIPE_HOME

./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the OVPI install 
directory and execute the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups

Custom Table Views

If you created one or more custom views for tables, the views you created may interfere with 
the report pack upgrade process, causing the process to fail. Whether your views interfere 
with the upgrade process depends on how you created them. If you created them using SQL, 
the upgrade will succeed, however, your views will not be available once the upgrade is 
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complete. If you created them using Datapipe Manager, the upgrade is likely to fail. To 
prevent the upgrade from failing, delete custom table views before you upgrade the report 
pack, then recreate the views after the report pack is upgraded.

Upgrading to Device Resource 3.1

To upgrade Device Resource on a stand-alone system, perform the following tasks:

Task 1: If necessary, save configuration data related to polling policies and polling groups

Task 2: If necessary, upgrade to Common Property Tables 3.5.

Task 3: Uninstall the datapipes you installed when you installed Device Resource 2.0.

Following is complete list of datapipes available for Device Resource:

1 Dev Res 3COM Datapipe 2.0

2 Dev Res Alcatel Datapipe 2.0

3 Dev Res Cisco Router Datapipe 3.0

4 Dev Res Cisco Switch Datapipe 3.0

5 Dev Res Enterasys Router Datapipe 1.0

6 Dev Res Enterasys Switch Datapipe 1.0

7 Dev Res Extreme Devices Datapipe 2.0

8 Dev Res Foundry Datapipe 2.0

9 Dev Res HP ProCurve Datapipe 3.0

10 Dev Res Juniper Router Datapipe 1.0

11 Dev Res Nortel Bay Datapipe 3.0

12 Dev Res Nortel Bay PP1X8X Router Datapipe 1.0

13 Dev Res Nortel Bay PP Access Datapipe 1.0

Task 4: Install the upgrade package for Device Resource 3.1; deploy reports.

Task 5: If the Packages directory contains new versions of the datapipes you were running with the previous 
version of Device Resource, install the new versions.

If you are upgrading Device Resource from 3.0 to 3.1, Task 3 may be unnecessary. Task 3 is 
definitely unnecessary if you do not intend to upgrade one or more datapipes. However, if the 
Packages directory contains new versions of the datapipes you are currently using, be sure to 
uninstall the old versions of those datapipes before you install the new versions.
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Post-Installation Steps

Once Device Resource has been upgraded, your first step is to reconfigure any polling policies 
and customized group definitions that need to be restored. Do not re-import the configurations 
you exported. Because the old datapipe may be incompatible with the new datapipe you just 
installed, re-importing a configuration you exported could lead to data corruption. In addition, 
if you deleted any custom table views, you can recreate those custom views now.

Removing Device Resource 3.1

Removing Device Resource automatically removes any datapipe that depends on Device 
Resource. Follow these steps to uninstall the Device Resource package.

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager and follow the on-screen directions for uninstalling packages; 
when prompted, select Device Resource for removal. When the uninstall process finishes, 
a package removal complete message appears.

4 Click Done.

5 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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3 The New Install
This chapter covers the following topics:

• Guidelines for a smooth install

• Installing Device Resource 3.1

• Removing Device Resource 3.1 

Guidelines for a Smooth Install

An OVPI reporting solution has at least two main ingredients, a report pack and a datapipe. 
Some reporting solutions include multiple datapipes. Installing a datapipe configures OVPI to 
collect a specific type of performance data at a specific interval. Installing a report pack 
configures OVPI to summarize and aggregate the data collected by the datapipe.

When you insert the report pack CD in the CD-ROM drive and launch the package extraction 
program, the install script copies packages from the CD to the Packages directory on your 
system. After the extract finishes, the install script prompts you to start Package Manager 
and follow the on-screen instructions. Before running Package Manager, review the following 
guidelines. 

Software Prerequisites

Device Resource 3.1 has the following prerequisites:

• OVPI 5.1

• All service packs available for OVPI 5.1

• Common Property Tables 3.5

If you are not currently running any version of Common Property Tables, let Package 
Manager install version 3.5 for you. If you are running an earlier version of Common Property 
Tables, upgrade to version 3.5. Installing the upgrade packages for Common Property Tables 
is easy. However, if you need assistance or if you want to know more about how this package 
operates, refer to the Common Property Tables 3.5 User Guide.

Datapipes

The datapipes that collect data for this report pack are not prerequisites. You may install the 
datapipes when you install the report pack or you may install the datapipes after you install 
the report pack. The following datapipes are available for installation:

6 Dev Res 3COM Datapipe 2.0

7 Dev Res Alcatel Datapipe 2.0
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8 Dev Res Cisco Router Datapipe 3.0

9 Dev Res Cisco Switch Datapipe 3.0

10 Dev Res Enterasys Router Datapipe 1.0

11 Dev Res Enterasys Switch Datapipe 1.0

12 Dev Res Extreme Devices Datapipe 2.0

13 Dev Res Foundry Datapipe 2.0

14 Dev Res HP ProCurve Datapipe 3.0

15 Dev Res Juniper Router Datapipe 1.0

16 Dev Res Nortel Bay Datapipe 3.0

17 Dev Res Nortel Bay PP1X8X Router Datapipe 1.0

18 Dev Res Nortel Bay PP Access Datapipe 1.0

Thresholding and Alarms

If your OVPI and NNM servers are integrated, you will probably want to install the 
thresholds sub-package, Device_Resource_Thresholds, on your OVPI server. This optional 
package contains customized thresholds. If you install it, the threshold traps generated by 
OVPI will display as alarms in the NNM alarm browser. 

If you install the thresholds sub-package, Package Manager will install the Thresholds 
Module for you, automatically. The Thresholds Module controls the actions that OVPI takes in 
response to a threshold breach. For details about configuring new actions, see the Thresholds 
Module 5.0 User Guide. 

Distributed Environments

If you intend to run Device Resource in a distributed environment, the installation procedure 
is more complex. Here is an overview of the steps:

1 Make sure that every server is running the same version of OVPI.

2 Make sure that every server is running all available service packs for OVPI. 

3 Disable trendcopy on the central server.

4 Install the following packages on the central server:

• Device Resource; deploy reports 

• Device_Resource_Thresholds

• Common Property Tables 3.5; deploy reports (forms in this context)

5 Install the following packages on each satellite server:

• Device Resource; deploy reports

• Common Property Tables 3.5

• Device_Resource_Thresholds

• At least one datapipe

6 Re-enable trendcopy on the central server.
18 Chapter 3



After installing Device Resource on OVPI servers in a distributed environment, you have to 
configure the environment by setting up connections with satellite server databases, 
configuring the central server with trendcopy pull commands, and switching off aggregations 
at each satellite server. These tasks are covered in Chapter 4, Distributed Systems.

Installing Device Resource 3.1

Follow these steps to install Device Resource 3.1:

1 Log in to the system. On UNIX® systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. 

Windows: The Main Menu opens automatically. 

UNIX: 

a Mount the CD (if the CD does not mount automatically).

b Navigate to the top level directory on the CD.

c Run ./setup

4 Type 1 in the choice field and press Enter. 

After the install script has copied every package to the Packages directory on your system, 
follow the prompts to launch Performance Insight and start Package Manager. The 
Package Manager welcome window opens.

5 Click Next. The Package Location window opens.

6 Click Install. 

7 Approve the default destination directory or browse to a different directory, if necessary, 
and click Next. The Report Deployment window opens. Type your username and password 
for the OVPI Application Server

8 Click Next. The Package Selection window opens. 

9 Click the check box for the following packages:

Device Resource 3.0

Device Resource Thresholds [optional]

Device Resource Demo Package [optional]

10 Click the check box for at least one datapipe.

11 Click Next. The Type Discovery window opens. 
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12 To run Type Discovery immediately after package installation, accept the default and 
click Next. The Selection Summary window opens.

13 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package installation complete message appears.

14 Click Done. 

15 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Options for Viewing Reports

When you installed Device Resource, you enabled the Deploy Reports option. As a result, the 
reports in this package (as well as any associated forms) were deployed to the OVPI 
Application Server. Once reports reside on the OVPI Application Server, you have two ways to 
view them:

• OVPI client applications

• Web browser

If the client applications are installed on your system, you have access to Report Viewer, 
Report Builder, and the Management Console. If the clients are not installed on your system, 
using a web browser is the only way you can view reports.

For more information about the client applications, refer to the OVPI Installation Guide. For 
more information about the Management Console, including how to use the Object/Property 
Management view to launch reports, refer to the OVPI Administration Guide.

Seeing Performance Data 

Some reports populate with data sooner than others. The first report to populate with data is 
the Near Real Time report. You will begin to see data in this report immediately after the first 
data collection completes. 

Any report that begins with an analysis of yesterday’s performance will need at least one full 
day’s worth of data before results are viewable. You will begin to see forecast data soon, within 
a few days. However, reliable forecast data will not be available for about six weeks, when the 
rolling baseline is complete.
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Removing Device Resource 3.1

Removing Device Resource automatically removes any datapipe that depends on Device 
Resource. Follow these steps to uninstall the Device Resource package.

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager and follow the on-screen directions for uninstalling packages; 
when prompted, select Device Resource for removal. When the uninstall process finishes, 
a package removal complete message appears.

4 Click Done.

5 Restart OVPI Timer.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On UNIX, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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4 Distributed Systems
This chapter covers the following topics:

• Installing Device Resource on multiple servers

• Configuring the central sever

• Configuring satellite servers

• System clocks

Installing Device Resource on Multiple Servers

If you intend to run Device Resource as a distributed system, each server in the system must 
be configured. Before configuring the servers, verify that package installation was done 
correctly. Here are the guidelines for package installation in a distributed environment:

• Install Device Resource 3.1 on every server.

• Install at least one datapipe on each satellite server.

• If you want to enable thresholding for aggregated data only, install the thresholds 
sub-package and the Thresholds Module on the central server.

• If you want to enable thresholding for hourly data or rate data, install the thresholds 
sub-package and the Thresholds Module on satellite servers. 

Configuring the Central Server

Perform these tasks to configure the central server:

• Task 1: Set up connections with satellite server databases

• Task 2: Configure trendcopy pull commands for hourly data

• Task 3: Configure trendcopy pull commands for rate data (optional)

Task 1: Set up connections with satellite server databases

1 Select HP OpenView > Performance Insight > Management Console.

2 Click the Systems icon on the lower left. The System/Network Administration pane opens.

3 Right-click the Databases folder. When prompted, select Add OVPI Database. The Add 
Database Wizard opens. 

4 Click Next.

5 Type the hostname and port number for the database you want to add; click Next.
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6 Review the Summary. Repeat Steps 4 and 5 for each additional database.

7 When you finish adding databases, click Finish. 

Task 2:Configure trendcopy pull commands for hourly data

1 Open the following file:

$DPIPE_HOME/scripts/DeviceResourceReporting_hourly.pro

2 Uncomment the copy commands in block2.

3 Modify the copy commands in the hourly_copy block as follows:

• Replace SATELLITE_SERVER_1_DATABASE with the name of the satellite server 
configured in Task 1.

• Replace THIS_MACHINE_DATABASE with the name of the central server.

4 If you have two or more satellite servers, create and configure hourly copy commands for 
each satellite server. 

5 If you are not running collections on the central server, comment out the block1 section.

Task 3:Configure trendcopy pull commands for rate data (optional)

If you want to view Near Real Time reports on the central server, rate data must be available 
on the central server. Follow these steps to pull rate data from satellite servers:

1 If it is not already open, open the following file:

$DPIPE_HOME/scripts/DeviceResourceReporting_hourly.pro

2 Make the following modifications to replicated trendcopy commands in block2:

• Change SHDevRes_Device to SRDevRes_Device

• Change SHDevRes_DeviceMem to SRDevRes_DeviceMem

• Change SHDevRes_DeviceCard to SRDevRes_DeviceCard 

3 Cut the block1 trendsums and paste them below the block2 trendcopies. 

Configuring Satellite Servers

Follow these steps to configure a satellite server:

1 If you disable the higher aggregations on a satellite server, you disable local reporting. So 
don’t disable the higher aggregations if you need local reporting. If you do not need local 
reporting, follow these steps to disable daily aggregations: 

• Open this file: $DPIPE_HOME/lib/trendtimer.sched

• Comment out lines referencing DeviceResourceReporting_Daily.pro.

2 Change the default that determines when hourly processing begins; make hourly 
processing begin sooner:

Copying rate data from satellite servers every hour has side-effects: 
more traffic between servers and a higher load on the central 
server.
24 Chapter 4



• Open this file: $DPIPE_HOME/lib/trendtimer.sched

• Locate the trendtimer entry in the DeviceResourceReporting_Hourly.pro file. 
By default, hourly processing begins at 40 minutes after the hour. 

• To make sure the satellite server completes hourly summarizations before the central 
server begins to copy data from the satellite server, change the start time from 
1:00+40 to 1:00+25.

3 Configure datapipe polling policies; make sure that each network device is polled by one 
satellite server only.

4 If you are using remote pollers, avoid duplicate polling between remote pollers and 
duplicate polling between a satellite and a remote poller.

5 If a satellite server has two or more remote pollers, create separate polling policies for 
each remote poller and use views and types to separate the devices.

System Clocks

Verify that the system clock on each satellite server is synchronized with the system clock on 
the central server.
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5 Exception Thresholds
This chapter covers the following topics: 

• Default thresholds for exceptions

• Using the change form to modify thresholds

Default Thresholds for Exceptions

The Device_Resource_Thresholds sub-package imposes an exception threshold on CPU 
utilization, memory utilization, and buffer utilization. When performance reaches one of these 
defaults, the thresholds sub-package sends a trap to the network management system. If your 
OVPI and NNM servers are integrated, the thresholds sub-package sends the trap to NNM. 
The trap becomes an alarm in the NNM alarm browser.

The following table describes the condition behind each threshold breach and the severity of 
the alarm sent in response to the breach.

You do not have to do anything to enable these thresholds. However, if you want to enable 
multiple types of traps, or set up multiple trap destinations, you must configure the 
Thresholds Module. For details, refer to the Thresholds Module 5.0 User Guide. 

Using the Change Form

Device Resource 3.1 includes a change form for modifying default thresholds. Follow these 
steps to access the Update Thresholds form:

1 Click the Objects icon in the panel on the left side of the Management Console window. 
The Object/Property Management view opens. 

Object Manager shows a list of objects. The type of object presented depends on which 
Object Manager View is open:

• The Device view (the default) shows a list of devices

• The Customer view shows a list of customers

Metric Threshold Severity

CPU 85% Medium

Memory 85% Medium

Buffer 85% Medium
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• The Location view shows a list of locations

2 To change the view, select View > Change View and use the pop-up window to select a 
different view. 

3 When you see the type of object you are interested in updating, select the particular object 
you would like to update. Object Specific Tasks appears in the window on the right. 

4 Double-click the task to open the Update Thresholds form, shown below.
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6 Top Ten Reports
Device Resource contains three Top Ten reports:

• Customer Top Ten

• Device Top Ten

• Location Top Ten

Use these reports to identify which customers, locations, and devices rank worst in terms of 
CPU, memory, and buffer utilization. The customer report aggregates statistics for groups of 
devices belonging to one customer, while the location report aggregates statistics for groups of 
devices at various locations belonging to one customer. The device report does not aggregate 
data. It displays statistics for the individual devices belonging to one customer. 

In addition to ranking customers, locations, or devices, each Top Ten report also sorts items by 
highest F90 value, the utilization level that OVPI predicts will be in effect 90 days from today. 
Note that left and right tables are independent and that an item appearing in the worst 
performing table on the left may not appear in the forecast table on the right. If the same item 
appears in both tables, you can assume that yesterday’s performance is part of a longer-term 
trend that may call for corrective action.

The tables on the left provide statistics for yesterday’s average utilization and yesterday’s 
busy hour. Table entries sort according to average utilization, highest to lowest. The tables on 
the right provide statistics for baseline, F30, F60, and F90; table entries sort by F90 value, 
highest to lowest. Baseline here means average busy hour.

The Device Top Ten begins with a customer summary table that sorts customers by resource 
utilization, highest to lowest. The Customer Top Ten and the Location Top Ten begin with a 
customer exception count table that sorts customers by yesterday’s total exception count, 
highest to lowest.

See below for samples of all three Top Ten reports.
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7 Summary Reports
Summary reports focus on groups of devices rather than individual devices. If a graph 
monitors utilization for all the devices belonging to one customer, or all the devices in one 
location, you are looking at a summary report. If a graph provides hourly and daily data, and 
the samples that constitute the hourly value and the daily value are based on averages, again 
you are looking at a summary report. 

The customer summary report focuses initially on the threshold exception count for specific 
customers. Customers sort by the number of exceptions, highest to lowest. The graphs below 
track CPU, memory, and buffer utilization. A bar chart displays the exception count 
hour-by-hour and day-by-day, while the Grade of Service chart provides an overall score for 
the customer, hour-by-hour and day-by-day. Use the Customer Summary to look at resource 
utilization customer by customer. 

The location summary is exactly the same as the customer summary, except for the location 
selection table providing an exception count for all the locations belonging to one customer. 
The graphs look at resource utilization for all the devices in one specific location. A bar chart 
displays the exception count hour-by-hour and day-by-day for this location, while the Grade of 
Service chart provides an overall score for this location on an hourly and daily basis.

The historical summary reports focus initially on busy hour and then provide detailed 
analysis, in the form of hourly and daily aggregations, for individual devices or individual 
cards on one device. The first table sorts customers by aggregated busy hour, highest to 
lowest, allowing you to easily compare one customer to another. Select a customer to populate 
a table of devices belonging to that customer, sorted by resource utilization, highest to lowest. 
Select a device to populate a frequency distribution pie chart and graphs that track average 
and maximum utilization for CPU, memory, and buffer. Here, maximum utilization is a single 
sample, specifically, the highest sample for the hour or for the day, not an average of multiple 
samples. 

Like the historical summaries, the exception summary is device-specific. This report 
focuses initially on exception counts per customer. Select a customer to populate a table 
showing which devices were responsible for those exception counts. Use the hourly graphs to 
find out exactly when those exceptions took place. Compare the hourly graph to the daily 
graph to find out whether yesterday’s exception count is an isolated incident or part of a 
longer-term trend.

See below for samples of all six summary reports, including the backplane historical 
summary.
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8 Forecast Reports
The three forecast reports in Device Resource focus on Days to Threshold (DTT) and provide 
estimates for future utilization. The threshold is 90% utilization, and the value for DTT 
indicates how close the device is to reaching 90% utilization. 

The customer and location reports are actually summary reports, aggregating data by 
customer or by location. The DTT values in these reports are actually averages across all 
devices for that customer, or all devices in that location. For example, if the memory 
utilization DTT is 17 for a customer, many devices could be closer to that threshold while 
many devices could be further away from it.

If you want to see which customer is closest to a threshold, or which location is closest to a 
threshold, start with the summary reports. If a customer or device looks suspicious, use the 
device report to pinpoint the devices that appear to be causing the problem. The device report 
provides DTT and forecasts for specific devices; the data is not aggregated.

All three reports use the same criterion for inclusion: a customer, location, or device appears 
in the report if CPU, buffer, or memory utilization is expected to exceed the exception 
threshold sometime within the next 90 days. The three graphs under the DTT data allow you 
to find out which resource is contributing to the problem. Each graph has three tabs:

• Standard

• Day of Week

• History

Use the standard graph to compare the baseline (average busy hour during the baseline 
period) to F30, F60, and F90. Use the day of week graph to compare the baseline to F30, F60, 
and F90 on a day of week basis and to find out whether resource usage is correlating with a 
particular day of the week. Use the history graph to compare average utilization to busy hour 
utilization over the baseline period. In the hourly graph, average utilization is based on four 
samples. In the daily graph average utilization is based on 96 samples (4 samples per hour, 24 
hours per day).

The F30, F60, and F90 values are produced by applying linear regression to busy hour values 
recorded over the baseline period. Busy hour is the highest average utilization for the day.   
During that hour, actual utilization may have been considerably higher for at least a portion 
of the hour. Busy hour reflects a persistent event, not a momentary spike. When busy hour is 
high, you want average utilization to be low. If average utilization is high, you know that 
resource utilization has been high for an extended period of time.
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9 Service Level Management
The Service Level Management report focuses on the availability of individual devices and 
network response time. Use this report to see if availability and network response time are 
meeting levels guaranteed by service level agreements.

An available device is a device that returns a request from the polling agent. The calculation 
that determines availability has limitations. Although it can compensate for network issues 
that may prevent the device from responding to a polling request, it cannot tell the difference 
between a device that is down and a device that is busy and not able to respond. Given this 
limitation, you may want to use the availability statistics in this report as one indicator of 
device availability, not your only indicator of device availability.

Network response time is defined as the length of time that elapses from the moment a 
request is sent by the datapipe to the moment the answer is received by the datapipe. This 
perspective on response time is different from the user’s perspective. Since the perspectives 
are different, you should interpret response time increases as an indicator that traffic may be 
congested and that the delay experienced by users may be comparable.

Selecting a customer from the customer list populates two tables:

• Devices sorted by availability

• Devices sorted by network response time

The first table sorts devices by availability, highest to lowest. The second table sorts devices 
by busy hour, highest to lowest. 

Selecting a device populates two graphs:

• Device availability, hourly and daily

• Average network response time vs. busy hour network response time

The hourly view of device availability covers a 24-hour period, midnight to midnight. The 
daily view begins with yesterday and covers the previous two weeks. If you see low 
availability, or high response time, compare yesterday’s performance with performance over 
the past two weeks to see whether yesterday’s performance is consistent with recent history 
or different from recent history.
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10 Near Real Time Reports
The two Near Real Reports in Device Resource—the QuickView and the Snapshot version of 
the QuickView—focus on resource utilization over the last six hours and the last 24 hours. 
The selection table at the top of the report sorts devices by resource utilization, highest to 
lowest. It displays average utilization for CPU, memory, and buffer, using for input all the 
samples taken during the last six hours, which, in practice, means approximately 24 samples. 
If samples are taken every 15 minutes, then the most recent sample in this average is only a 
few minutes old. 

While the table at the top of the report provides averages for the previous six hours, the CPU, 
memory, and buffer graphs monitor activity over the previous 24 hours. You also have a grade 
of service chart that ranks service quality over the last six hours. Since the Near Real Time 
report is recalculated after every poll, you can use this chart to find out whether a situation 
you are watching closely is improving or getting worse.

Because the table at the top highlights devices with the worst utilization, you can use the 
NRT QuickView to identify which devices, if any, are having trouble. In addition, if an average 
in the table seems abnormal, you can compare the average in the table to the previous 24 
hours to see if the current average reflects an existing condition or something completely new. 
If a summary report for yesterday points to a situation that could become problematic, the 
Near Real Time report will tell you whether that condition is improving, worsening, or staying 
about the same. The benefit of course is that the advance warning you get from this report 
will let you correct the problem before it becomes a serious issue for users. 

Due to space limitations, the time period in the three rate data graphs may be partially 
concealed. You can easily improve your view of the data by right-clicking the graph, selecting 
View in New Frame, and resizing the window. Once resized, every hour will be clearly 
visible. 

The Snapshot version of the Near Real Time QuickView operates just like the Snapshot 
version of the Historical Summary. Launch the report, then respond to the prompts that ask 
you which device or devices you want included. If a summary, top ten, or forecast report has 
already alerted you to a device with resource problems, and this device is not appearing in the 
NRT QuickView, you can launch the Snapshot version to see where utilization levels are right 
now and what has happened since yesterday.

See below for samples of these reports: 

• QuickView NRT

• QuickView NRT Snapshot

• Backplane NRT
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A Editing Tables and Graphs
Any table or graph can be viewed in several ways. While the default view is usually adequate, 
you can easily change to a different view. If you are using Report Viewer, right-click the object 
to display a list of view options. If you are using the Web Access Server, follow these steps to 
change the default view of a table or graph:

1 Click Preferences on the links bar.

2 Expand Reports in the navigation frame.

3 Click Viewing.

4 Select the Allow element editing box.

5 Click Apply.

6 Click  (the Edit icon) next to the table or graph. 

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options.

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens.
 63



Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 

View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 
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The following table provides details about each option.

Style Options

Select Style to display a list of seven view options for graphs.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.

Export Element as CSV... Same as the table option shown above.

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below.

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten.
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Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers.

Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day.

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 
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Display Data Table

This option changes a graph into a spreadsheet. 

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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Glossary
Availability

The percentage of time the device is operational. This measurement accounts for outages 
indicated by the sysUpTime variable; however, it does not account for periods of time the 
device could not be reached by OVPI.

Average utilization

In an hourly graph, this value is an average of four samples taken over a one-hour period. In a 
daily graph, this value is an average of 96 samples taken over a 24-hour period.

Baseline

The average busy hour over the baseline period. Rate of growth, a statistic that appears in 
forecast reports, is calculated by dividing F30 by the average busy hour.

Baseline period

The previous 91 days. Forecasts for F30, F60, and F90 are based on performance during the 
baseline period.

Buffer utilization exception

Recorded when buffer utilization exceeds the allowable threshold.

Buffer utilization threshold

When buffer utilization is above this value, an exception is generated. The default value for 
the threshold is 85%.

Busy Hour

The definition varies depending on what is being measured. Busy hour is either a busy hour 
total, or a busy hour average. A busy hour total points to the hour of the day that recorded the 
highest number of events, for example, the highest number of buffer utilization exceptions or 
the highest number of memory utilization exceptions. In Device Resource, busy hour is the 
highest hourly average for the day. Busy hour, unlike peak, is a relatively persistent event 
with greater consequences for network users. Compared to busy hour, peak is momentary. 

Since busy hour is an average, you can assume that actual utilization could have been 
significantly higher or lower during the course of that hour. Busy hour average refers to the 
highest hourly average among 24 hourly averages; this term is synonymous with busy hour. 
Average busy hour refers to an average of all busy hour values over the baseline period and is 
synonymous with baseline.

Card

Whether or not performance information at the card level is available depends on the make 
and model of the device. Some vendors maintain a distinction between CPU and card, and 
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some do not. Vendors who do maintain the distinction may not maintain it uniformly across 
all equipment. The card selection table in the card historical summary report may contain 
just one entry or it may contain multiple entries. If you see just one entry, either the device 
contains just one card, or the device contains multiple cards but it is not able to report 
multiple cards. If the device cannot report multiple cards, the statistics that display at the 
card level are exactly the same as the statistics that display at the device level.

Common Property Tables

Customer names can appear in reports if you import customer names using the Common 
Property Tables package. As explained in the Common Property Tables User Guide, two 
methods of property import are available, a batch-oriented property import utility, and a 
combination of online forms for creating and updating customers, locations, and nodes. If you 
do not import customer names, data from every customer will roll up under All Customers. If 
you do not import locations, data for all locations will roll up under All Locations.

CPE utilization exception

Recorded when CPU utilization exceeds the allowable threshold.

CPU utilization threshold

When CPU utilization exceeds this value, an exception is generated. The default value for the 
threshold is 85%. 

Daily

A view of performance that compares average utilization to busy hour utilization. The number 
of days that you can see in this view depends on the number of days that data has been 
collected. The maximum number of days is the rolling baseline, 91 days. Note that daily views 
also include performance data from yesterday, the same data currently visible in the hourly 
view, rolled up as one average and one busy hour.

Days to Threshold (DTT)

The number of days that will elapse before utilization is expected to reach 90%. Device 
Resource calculates DTT for CPU utilization, memory utilization, and buffer utilization.

Device

A router or a switch, not a server. In selection tables, devices are listed by IP address or 
hostname. 

Grade of Service

A total score based on a combination of contributing scores, sometimes equally weighted, 
sometimes not. In Device Resource the GOS is equally-weighted and it combines scores for 
memory, buffer, and CPU as follows: 

GOS =  GOS memory +  GOS buffer +  GOS CPU

Hourly

An average derived from four collections taken once every 15 minutes; also a graph showing 
yesterday’s hourly increases and decreases. 

1
3
--- 1

3
--- 1

3
---
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Memory utilization exception

Recorded when memory utilization exceeds the allowable threshold.

Memory utilization threshold

When memory utilization exceeds this value, an exception is generated. The default value is 
85%.

Near Real Time

An average for performance over the previous six hours, ending with the most recent poll. If 
polling takes place 4 times per hour, the NRT average is derived from 24 samples. The NRT 
average is a rolling average and is recalculated at the conclusion of each poll. 

Network response time

The time that elapses from the moment the poller sends an SNMP request to a device to the 
moment the poller receives a response from the device. 

RCT

Range count.  The number of samples that fell above a specified minimum and below a 
specified maximum

STD

Standard deviation. Appears as a column in database forecast tables.

TCT

The number of samples above a specified value.

Summary

An aggregation of multiple samples. In an hourly graph, an average based on multiple 
samples collected during one hour; in a daily graph, an average based on multiple samples 
collected over the course of each day. In customer and location reports, an aggregation of 
multiple averages for multiple devices across the same hour, the same day, or the same 
month.

Utilization

Utilization for a time period, measured as a percentage; the value of the metric in use divided 
by the total available resources for that metric, multiplied by 100.
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R
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